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Notations Used in This Guide

The following table shows the symbols used in this manual, along with descriptions of what they mean.

A\l
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Indicates additional information and points which may be useful to know regarding a topic.

Timer (Boldface)

- Indicates a page where detailed information regarding a topic can be found.
Procedure Indicates operating methods and the order of operations.
The procedure indicated should be carried out in the order of the numbered steps.
[ (Name) ] Indicates the name of the buttons on the projector's remote control or the control panel.
Example: Esc button
"(Name)" Indicates the name of the buttons on the EasyMP Monitor or OS screens.

Example:

Select "Timer" - "Timer Settings".
Select Timer - Timer Settings.
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Tasks that can be done using EasyMP Monitor

Tasks that can be done using EasyMP Monitor e Mail notification function settings
EasyMP Monitor lets you carry out operations such as checking the
status of multiple EPSON projectors that are connected to a network and
controlling the projectors from the computer.

You can set e-mail addresses to which notifications are sent if a status
requiring attention, such as a problem, occurs with a projector that has
been registered.

Following are brief descriptions of the monitoring and control functions

¢ Sending messages to registered projectors
that can be carried out using EasyMP Monitor.

You can send JPEG files to the registered projectors at once by using

* Registering projectors for monitoring and control Message Broadcasting, which is a plug-in software for EasyMP

Projectors on the network can be searched for automatically, and you Monitor.

can then select projectors to be registered from the projectors that are Message Broadcasting is not available for all projector models. For
detected. compatibility information, and to download the software and manual,
You can enter the IP addresses for target projectors to register them. visit www.epson.com, select your location, and select your product.

¢ Registered projectors can also be assigned to groups so that they can
be monitored and controlled in groups.

e Monitoring the statuses of registered projectors

The power status (ON/OFF) for projectors and problems or warnings
requiring attention can be checked visually by means of icons.

You can select groups of projectors or a single projector that you are
interested in, and then check the cumulative lamp operating time or the = a0 an-ans-e
details of information such as input sources, problems, and warnings
for these projectors.
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¢ Controlling registered projectors

then carry out operations for the selected projectors such as turning the
power on and off and switching their input sources.

Web control functions can be used to change the settings in the
projector's configuration menu.

If there are certain control actions which are carried out regularly at
particular times or on particular days, you can use Timer Settings to
register timer settings.

Projectors can be selected in groups or as single projectors, and you can [




Installing EasyMP Monitor

Installing EasyMP Monitor

Operating environment

This software is compatible with computers that comply with the
following requirements.

e Operations carried out at the computer may become slow depending
on the number of projectors being managed. If this happens, use a
computer with higher specifications.

e EasyMP Monitor cannot be used in environments which do not allow
pings to be transmitted.

0S Windows 2000 Professional SP4
Windows XP Home Edition SP2/SP3"
Windows XP Professional SP2/SP3”

Windows Vista"
(All editions except Starter Edition)

Windows Vista SP1/5P2"
(All editions except Starter Edition)

Windows 7 32 bit version
(All editions except Starter Edition)

Windows 7 64 bit version

e Internet Explorer Ver. 5.0 or later must be installed.

CPU Pentium MMX 166 MHz or higher (Pentium Il 233 MHz
or higher recommended)

Memory 64 MB or more (128 MB or more recommended)
capacity

Free hard disk 50 MB or more

space

Display SVGA (800 x 600) or higher resolution, 32 bit or higher

display color

*

Supports only 32 bit version of OS.

e Macintosh computers cannot be used.

Transferring the settings

If you are already using EasyMP or EMP Monitor, you can transfer the
projector settings to this version. The settings are stored as a data file
(EMP Monitor.dat). Make a copy of the EMP Monitor.dat before you
install this software. EMP Monitor.dat can be found at the following
location if the default settings were used to install the software:

e If your operating system is Windows 2000 or Windows XP

"C:\Program Files\EPSON Projector\EasyMP (or EMP) Monitor Ver.
x.xx (Ver. x.xx represents the software version)"

e If your operating system is Windows Vista or Windows 7

"C:\Users\(User Name)\AppData\Local\VirtualStore\Program
Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. x.xx (Ver. x.xx
represents the software version)"

If you cannot find the "AppData" folder, click "Start" - "Control Panel"
- "Appearance and Personalization" - "Folder Options". Select "View"
tab, and then configure the "Show hidden files, folders, and drives"
setting in "Advanced settings".

After installing this software, follow the instructions below before
starting EasyMP Monitor to transfer the settings.

e If your operating system is Windows 2000 or Windows XP

Overwrite the existing EMP Monitor.dat file with the copy you made.
The existing EMP Monitor.dat file is in "C:\Program Files\EPSON
Projector\EasyMP Monitor Ver.x.xx".
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e If your operating system is Windows Vista or Windows 7

Place the copy of the EMP Monitor.dat file in "C:\Users\(User
Name)\AppData\Local\VirtualStore\Program Files\EPSON
Projector\EasyMP Monitor Ver.x.xx".

~

- - The software name has been changed.
Before: EMP Monitor — After: EasyMP Monitor

If you are already using EMP Monitor, you can replace with this software.

Installing

You must have administrator authority in order to install EasyMP
Monitor.

To download the software and manual, visit www.epson.com and select
your location.

Double-click the downloaded software file to start the install program.
Follow the on-screen instructions.

If EasyMP or EMP Monitor is already installed, uninstall it before
installing this software. @ "Uninstalling EasyMP Monitor" p.46

Limitations imposed by a Windows Vista or Windows
7 environment

When using EasyMP Monitor under Windows Vista or Windows 7, note
the following limitations.

¢ You must have administrator authority in order to use Register at
startup on the Environment setup screen of EasyMP
Monitor.® "Monitoring using the system tray" p.26

e If EasyMP Monitor is installed on your computer, uninstall it before
you update the operating system to Windows Vista or Windows 7.
Updating your OS without uninstalling the software may cause a
malfunction. @ "Uninstalling EasyMP Monitor" p.46

Before starting operations

Check the following points before starting up EasyMP Monitor.

e EasyMP Monitor must be installed on the computer to be used for
monitoring and control.

e The computer and the projectors must be connected to the network.

¢ Depending on the projector model, a commercially-available serial «»
TCP/IP conversion adapter and a connection cable are required in
order to use EasyMP Monitor. See your projector's User's Guide.

Make the settings for the serial «» TCP/IP conversion adapter before
connecting to the projector.

,@: To enable projectors to be monitored and controlled even when they are in

’ standby mode’, make the following settings at the projectors. The settings
that need to be made will vary depending on the projector you are using.
See your User's Guide for more information.

o Set Standby Mode to Communication On (or Network On).
e Set Network Monitoring to On.

* When the projector's () indicator is lit orange.
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Registering and deleting projectors for monitoring

Registering and deleting projectors for monitoring The main window will be displayed.

This operation is carried out when starting EasyMP Monitor for the first The red box area described in the screen below is referred to as
time after it has been installed and when you would like to add
projectors. Once a projector has been registered, the status for the
projector will be displayed automatically each time EasyMP Monitor is
started from that point onwards.

Grouping view.
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The operations to register projectors vary depending on where the
projectors are connected on the network.

e When registering a projector that is located in the same segment as the
computer in which EasyMP Monitor is installed. @ "Registering
projectors using automatic search (Searching for and registering
projectors that are located in the same segment)" p.11

e When registering projectors that are in multiple segments of the
network. @ "Setting the range of addresses to do an automatic search
and registration” p.13

Starting EasyMP Monitor

Procedure
7\
%@ Click "Start" - "Programs" (or "All Programs") - "EPSON
Projector" - "EasyMP Monitor Ver.x.xx" in that order to start
EasyMP Monitor.

% i
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Registering projectors using automatic search
(Searching for and registering projectors that are
located in the same segment)

Procedures for automatic search
Procedure

%@§ Right-click in Grouping view and select "New" - "Projector
(automatic search)".

The following Create new projector (automatic registration) win-
dow will be displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.

Create new projectar {automatic registration)

[ Specfy an address range and szarch,

Start address End address

Search Edit Cancel

:@: You can also carry out this operation by selecting New - Projector
(automatic search) from the Edit menu.

%@ Click "Search".
Automatic searching will be carried out, and the names of the pro-
jectors that have been detected will be displayed.

If a projector does not appear in the list, use "Registration by spec-
ifying an IP address (Manual registration)". @ p.16

Create new projector {automatic registration;)

Projector name IP address
Frojector!O 192168040
Projector]l 192168041
Frojector!2 192168042
Projector] 3 192168043
Projectar]4 192168044
Projectar]s 192168045
Frojectorlf 192168046

[ Specify an address range and search.

Start address End address
Search Edit Cancel
\\ ! ,—
~@: Projectors that are using a serial «» TCP/IP conversion adapter cannot be
4
’

detected.
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Procedures for registration

Procedure

and then click "Edit".
The following window will be displayed.

Display name | |
Dizplay icon

- o

| | i
Parent group |[None] j
Projectar name | Projector1l
IP gddress | 169 . 25¢ . 182 . 151 Search
-
Part Mumber ’7
Monitor Pagsword |
D escription
[v ' I onitar

Register Cancel

Make the necessary settings while referring to the following table.

Display name

Enter the name of the projector(s) to be
displayed in Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A
space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping
view or Detail list view.

Parent group | Select when registering a projector in a group.
If no groups have been created, this cannot be
selected.

@ "Registering several projectors to a
monitoring group all at once" p.17

Projector This shows the name that has been registered on

name the projector.

IP address This shows the IP address for the registered

projector.

Use Serial
TCP/IP
conversion
adaptor.

This cannot be selected when registering
projectors using automatic search.

Port Number

This cannot be selected when registering
projectors using automatic search.

Monitor
Password

If a Monitor Password has been set for the
projector, be sure to enter the Monitor Password
that has been set. If the correct password is not
entered at this time, it will not be possible to
monitor and control the projector even though it
is registered.

Description

You can enter a memo about the projector. The
details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.
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Monitor

Select this when you want monitoring to start.

§<» R,
%@ After entering the details, click "Register" to start the
registration. When the message is displayed, click "OK".

To continue registering other projector(s), repeat Steps 1 and 2.

:@3 Projectors that have been registered using automatic search are searched
! for again by projector name each time EasyMP Monitor is started.

§<» ””%
%@ To end the registration operation, click [X] in the top-right
corner of the window or click "Cancel".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Refer to @ "Monitoring window layout" p.20 for details on using
the Grouping view and Detail list view.

Setting the range of addresses to do an automatic
search and registration

:@:— Projectors that are using a serial «» TCP/IP conversion adapter cannot be
’ detected.

Procedures for automatic search

Procedure

Right-click in Grouping view and select "New" - "Projector
(automatic search)".

The Create new projector (automatic registration) window will be
displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.

%§ Select the "Specify an address range and search." check box
and then enter "Start address" and "End address" in the
range.

Create new projeckor (automatic registration)

Iv Bpecify an address range and search.
( 192 . 165 . 0 . 00 )gd address ( 192 188 . 0 . 50 "
v

Edit Cancel

Start address

Search
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=

“ /' Click "Search".

Automatic searching will be carried out, and the names of the pro-
jectors that have been detected will be displayed.

Create new projector {automatic registration)

Projector name IP address
Projector10 192168040
Projector1i 192168041
Projector12 192168042
Projector13 192168043
Projector1d 192163044
Projector1d 192168045
Projector1G 192168046

|v Specify an address range and search,

Start address 192 ., 168 . 0 ., 00 End address 192 . 168 . 0 ., 50

I Search I Edit I Cancel I
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Procedures for registration

Procedure

Select the projector to be registered from the displayed list,
and then click "Edit".

The following window will be displayed.

Create new projectar {automatic search)
Dizsplay hame | |
Dizplay jcon
H e o
ol | i
Parent group |[None] ﬂ
Frojectar hame | Projectar1l
IP ddress | 169 . 254 . 183 . 181 Search
-
Port Mumber ’7
tonitar Pazsword |
Description
v Monitar
Register Cancel

Make the necessary settings while referring to the following table.

Display name

Enter the name of the projector(s) to be
displayed in Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A
space cannot be used as the first character.

Display icon

Select the icon(s) to be displayed in Grouping
view or Detail list view.

Parent group | Select when registering a projector in a group.
If no groups have been created, this cannot be
selected. @ "Registering several projectors to a
monitoring group all at once" p.17

Projector This shows the name that has been registered on

name the projector.

IP address This shows the IP address for the registered

projector.

Use Serial
TCP/IP
conversion
adaptor.

This cannot be selected when registering
projectors using automatic search.

Port Number

This cannot be selected when registering
projectors using automatic search.

Monitor
Password

If a Monitor Password has been set for the
projector, be sure to enter the Monitor Password
that has been set. If the correct password is not
entered at this time, it will not be possible to
monitor and control the projector even though it
is registered.

Description

You can enter a memo about the projector. The
details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.
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§§w\u.mmf%

%§ After entering the details, click "Register" to start the

if

registration. When the message is displayed, click "OK".

To continue registering other projector(s), repeat Steps 1 and 2.

w%
%@§ To end the registration operation, click |E| in the top-right

corner of the window or click "Cancel".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Refer to @ "Monitoring window layout" p.20 for details on using
the Grouping view and Detail list view.

Registration by specifying an IP address (Manual
registration)

Procedure

§§w\u.mmf%

§ Right-click in Grouping view and select "New" - "Projector

(manual registration)".
The following window will be displayed.

If Detail list view is displayed, select New - Projector (manual reg-
istration) from the Edit menu.

Create new projector (manual registration)
Display name | |
Dizplay jicon
H e =

< | 2
Parent group | [Mane] ﬂ
Projector name |
IP address | Search
[ Use Serial < TCPAP corwversion adaptar,
Port Mumber ’7
tonitor Password |
Description
[v* | Manitor

Register Cancel




Registering and deleting projectors for monitoring

;@- You can also carry out this operation by selecting New - Projector (manual
registration) from the Edit menu.

/ Enter the IP address of the projector to be registered in the
"IP address" box and then click "Search". When the message
is displayed, click "OK".

If you are using a serial «» TCP/IP conversion adapter and cable to
connect the projector, select Use Serial «» TCP/IP conversion
adaptor., enter the port number in Port Number, and then click
Search.

After searching is complete, enter the information for the
projector to be registered while referring to the table below.

Display name | Enter the name of the projector(s) to be displayed
in Grouping view or Detail list view. Up to a
maximum of 32 bytes can be entered. A space
cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping
view or Detail list view.

Parent group | Select when registering a projector in a group. If
no groups have been created, this cannot be
selected. (See the next section for more
information on registering projectors to a group.)

Port Number

If you are using a serial «» TCP/IP conversion
adapter to connect the projector, enter the port
number.

Monitor
Password

If a Monitor Password has been set for the
projector, be sure to enter the Monitor Password
that has been set. If the correct password is not
entered at this time, it will not be possible to
monitor and control the projector even though it
is registered. If you are using a serial «» TCP/IP
conversion adapter to connect the projector, the
Monitor Password security function cannot be
used.

Description

You can enter a memo about the projector. The
details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.

‘ ) After entering the details, click "Register" to start the
registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Projector This shows the name that has been registered on

name the projector.

IP address This shows the IP address that you entered in step all
2.

Use Serial «» | Select this if you are using a serial «» TCP/IP

TCP/IP conversion adapter to connect the projector.

conversion

adaptor.

atonce

Registering several projectors to a monitoring group

Projectors that have been registered can then be registered together into
different groups so that they can be monitored and controlled together.

Furthermore, if you select one of the registered groups as the Parent
group, monitoring and control operations can be carried out for all
projectors in that Parent group.
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A Parent group can be set for other parent groups, so that a hierarchical
group arrangement can be created.

First, create the registration groups, and then register projectors into the
groups that have been created.

Procedure

Right-click in Grouping view and select "New" - "Group".

The following window will be displayed.

Make the necessary settings while referring to the table below.

If Detail list view is displayed, select New - Group from the Edit
menu.

Fiegister Cancsl

Group name Enter the name of the group to be displayed in

Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A
space cannot be used as the first character.

Display icon Select the icon to be displayed in Grouping view
or Detail list view.
Parent group | This selects the parent group. If no groups have

been created, this cannot be selected.

Monitor Select this to monitor all projectors that have
been registered in the group. If this is not
selected, the settings made when the individual
projectors were registered will be used.

It cannot be set when creating a new group.
\\ ! ,f
:@: You can also carry out this operation by selecting New - Group from the
’ Edit menu.

‘ ) When the setup is complete, click "Register" to start the
registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view.

Right-click the projector icon to register to the group you
have created in Grouping view or Detail list view, and select
"Edit".

:@: You can also carry out this operation by selecting Edit in the Edit menu.

‘ ) In the Edit projector window, select the group name to use
for registering in Parent group and then click "Change".

The status of the group registration will be displayed as an icon in
Grouping view or Detail list view.

E@: The registration details can also be checked using Projector list in the View
’ menu.
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If the projector name or IP address changes after
registration

For projectors that have been registered manually

Procedure

%@§ Right-click on a projector icon in Grouping view or Detail list
view and select "Monitoring disabled". Then right-click the
projector icon again and select "Edit".

You can also carry out these operations by using the Edit menu.

@»“““"”"%@%
@ If only the projector name has been changed, click "Search"
"~ in the Edit projector window that is displayed. If the IP
address has been changed, enter the new IP address in the
"IP address" box and then click "Search". When the message
is displayed, click "OK".

S
2

%@§ When the display returns to the Edit projector window, click
"Change".

For projectors that have been registered using automatic
search

Procedure

%@§ Delete the projector(s) whose name or IP address has been

changed in Grouping view or Detail list view. (See the next
section for more information on deleting projectors.)

/ Carry out automatic search to re-register the
projector(s). @ p.11

Cancelling projector registrations (Delete)

The registrations for projectors can be deleted if they are no longer
required for monitoring or control using EasyMP Monitor.

Procedure

Right-click the icon for the projector or group that is to be deleted
in Grouping view or Detail list view and select "Delete". When the
message is displayed, click "OK".

More than one projector can be selected for deleting by selecting in
Grouping view or Detail list view.

The methods of selecting more than one projector at the same time are as
follows.

e If you select a Group icon in Grouping view, all projectors that have
been registered in that group will be deleted at the same time.

¢ Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

e Use drag and drop to select a range of desired icons.

,@1 You can also carry out this operation by selecting Delete in the Edit menu.
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Monitoring window layout e Detail list view
This view lets you display the status of each projector as a list so that the
projectors can be checked in detail. You can also display specific items

Types of monitoring windows and switching method as a list, and sort display items using a specific row as a sort key.
Types of monitoring windows E e T =
=] [«] [
@ @ e
There are two types of monitoring windows. Select a desired window. § § —
e Grouping view - s I =
This view lets you check the status of group registrations in a 5 § —
hierarchical diagram. L2 °, e

Detail list view

=
v I 0o #EmaEssEomaaa
@ How to switch views
E 9 e o e :
o Grouping view and Detail list view are switched as follows.
8 9
i@ % © |

Grouping view
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Procedure

Click the View menu, and select "Grouping view" or "Detail list
view".

Monitoring using Grouping view

Meanings of Grouping view icons

In Grouping view, the patterns on the icons indicate the statuses of the

projectors. If the group icons are round in shape, it indicates that there is
another level below them. @ p.22

e Edit  Wiew Tool  Help

Rerssh | Seectal (7 OO 55 E - e =
E

Shawirao m A Showirao m B

&
b
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The icon patterns and their meanings are explained below. Projector
€5 | Network error (Monitor Password authentication error)
X : :
No warnings or problems No Monitor Password was entered when the projector was
All broiectors in the aroun are normal registered, or an incorrect Monitor Password was entered. @ p.12,
pro) group : p.15,p.16

@ Warning or problem @ Network error (TCP connection error) 2
A projector in the group has a warning or problem status. KX
Notification @ Network error (ESC/VP.net communication error) >

?
A projector requiring immediate attention has been detected ""
within the group.

. Monitoring disabled *1 When Temperature level display group view is set to On at Environment
The projector is not being monitored. If you right-click the icon and setup in the Tool menu, an icon indicating the internal temperature of the
select Monitoring enabled, the projéctor will be added to the projector will be displayed on top of the projector icon. The default setting

roiectors that are bein m(’)nitore d is Off. As you can get an idea of how the temperature inside the projector is
proJ 9 : increasing when Temperature level is displayed, you can make

ng Data being updated improvements to the projector's operating environment before a high

' internal temperature error or high-temperature warning occur. @ p.27

*2 Check the following items.
- Check that the projector's power is turned on.

G _ - Check that the LAN cable is connected.
3 No warnings or problems ! - Check that Standby Mode is set to Communication On (or Network On)
or Network Monitoring is set to On in the projector's configuration menu.

e Warning or problem *3 Check that the projector has been correctly connected to the network.

A /_
Notification E@- The projector information that is generated when a problem is detected is

’ stored until EasyMP Monitor is closed. EasyMP Monitor displays will not

Monitoring disabled be updated automatically even if the projector status returns to normal.
. Click "Refresh" in the main window to update the status.
& Data being updated
Using the icons in Grouping view

The following icon operations can be carried out in Grouping view.
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¢ Expanding and collapsing icons
Each time you double-click a group icon, the icons for the projector
that have been registered in that group are displayed or hidden.

¢ Moving icons
To change the position of an icon within Grouping view, simply drag
and drop the icon to be moved.

Monitoring using Detail list view

Meanings of Detail list view icons

The status of registered projectors is displayed as a list in Detail list view
regardless of which Group the projectors belong to.

1 I I I S T
Fle| Edt wew ool |Help
Refresh Select 4l O 5B S8 |y 3 3l 5 = B A g |eg YL
Type lfGiouprame = et ot infcimation
ey | [eranc cbby @ IH | |
= | tojectord! (@] 1204 | —|
[E5) | 2 toiectoil2 (@] 60H ||
@Ay | fpanet o @*R 15H ]
a3 | Joranc 02 (@) o | |
&) | [Branch avshommoomsshomoom . | o (@) E | |
(ad | foranch Asshowmoomishowroom 8 | Nad @ 20H | m——
(=) | |Branch Ashowroom/Showreom B 05 @ B8H | )
@ ||z o (@) 451 EEE=
&g | [pranc o1 (@) 100H EEE=
& | 02 @ B | |
) | 03 (@] 84 | |
(@3 | [Branch BReception Room com 1 (@] 7aH | —| i
(=g | JBranch B/Reception Room 0om 2 @ B0H | =] |
< [ 2
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The icon patterns and their meanings are explained below.

O Type
Displays the projector status.
@@ No warnings or problems*1

ve Warning or problem

An error has occurred on the projector.
&4 Notification

The projector requires immediate attention.
. Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to
the projectors that are being monitored.

g Data being updated
@ Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered.
@ p.12,p.15,p.16

@ Network error (TCP connection error
@ Network error (ESC/VP.net communication error

)2
)3
@ Group name

When projectors are registered to a group, the name of the group that
the projector belongs to is displayed.

© Display name
Shows the display name.
9 Power
Shows the power on status for the projector.
@© Poweronandnormalstatus @) Power off and normal status

@\ Poweron and abnormal @) Power off and abnormal
status status

® Lamp Hours

Shows the lamp operating time for the projector. If the projector has 2
lamps, it shows the lamp operating time for both lamp 1 and lamp 2.

® Temperature level

The following five icons display the differing internal temperature
status of the projector.

=1 Internal temperature == |nternal temperature

normal normal

[EEE ] High-temperature mmmE | High-temperature
warning warning

Internal temperature
error

@ Error information

Shows a notification or warning/problem status using the following
icons.

Clean Air Filter Notice
Replace Lamp (Lamp 1)
Lamp error (Lamp 1)

Replace Lamp™#
Replace Lamp (Lamp 2)
Lamp error (Lamp 2)

Lamp failure at power on
(Lamp 2)

Lamp failure at power on
(Lamp 1)

E sSeEgi

High-temperature warning Replace Air Filter

1 No Air Filter

Low Air Flow

Supply System Error (Ballast
1)

Cinema filter warning

Air Flow Sensor Err.

mm
11

3 #Hhid SN«

&

Supply System Error (Ballast

2)
Shutter warning Lamp Cover Open

Lamp Error (Lamp 1)

w=

Lamp Error

Lamp Error (Lamp 2) Lamp failure at power on

=N

=3

O
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*1

*2

*3
*4

[@ Lamp failureat poweron [ Lamp failure at power on
(Lamp 1) (Lamp 2)

[@ High internal temperature  [E Low air flow error
error

HE:‘ Air filter air flow sensor error Internal Error

4 Fanerror & Sensor error

Supply System Error [ Supply System Error (Ballast
(Ballast) 1)

[ Supply System Error (Ballast [@)] Auto Iris Error
2)

@ Cinema filter error i& Shutter error

(24 Cooling system error [@ Cooling system error
(Peltier element) (pump)

@ Othererror A\ Other warning

Exhaust vent shutter error

B

When Temperature level display group view is set to On at Environment
setup in the Tool menu, an icon indicating the internal temperature of the
projector will be displayed on top of the projector icon. The default setting
is Off.

Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On)
or Network Monitoring is set to On in the projector's configuration menu.

Check that the projector has been correctly connected to the network.

Using Environment setup in the Tool menu, you can set a duration of time
after which the Replace Lamp notification will appear. (The notification will
appear earlier if the lamp needs to be replaced before the selected time.)

,@- e The projector information that is generated when a problem is detected is

’ stored until EasyMP Monitor is closed. EasyMP Monitor displays will not
be updated automatically even if the projector status returns to normal.
Click "Refresh" in the main window to update the status.

e Detectable error information differs with the projector you are using.

Selecting display items

You can select only the required items to be displayed in Detail list view.

Procedure

Select "Option" from the View menu.

The Option window will be displayed.

Dizplay items

v Group name

[ Projector name
v Dizplay name

[ 1P address

v Poweer

Iv Lamp Hours

[ Souree

¥ Temperature level
[ Description

Iw Error information

0K Cancel

’ Select the check box of the item you want to display.
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7 e

&) dick"oK". Procedure

7N\
%@§ When all of the details of the item cannot be displayed in Select "Projector list" from the View menu.
Detail list view, drag the boundary line on the right of the

The following window will be displayed.
item name so that the view is extended to the desired width.

+ =) Convention Hall
@ Lobby

Sorting lists

. . . . =1 | Showroom
You can sort detailed lists by using a specific row as a sort key, such as Showroom &
projector name order or IP address order. % :012
Lu}
@ No3
Procedure + () Showraom B

+ (%3 Branch B
(3 Branch C

Click the item name of the row you want to use as the sort key.

With Projector list, temperature level icons are not displayed regardless
Searching for desired icons (Projector list) of the setting of Temperature level display group view at Environment

setup in the Tool menu.
The Projector list feature is useful for searching in lists when many

groups and projectors are registered and the icon you are looking for is
not displayed on screen.

The Projector list lets you check the registration details for groups in a
hierarchical diagram. When you click on an icon, Grouping view and

Detail list view are scrolled so that the selected icon is displayed in the
window.

Monitoring using the system tray

The projector statuses are always displayed as icons in the system tray,
even when Grouping view or Detail list view is not always displayed, and
the statuses can be checked by the icon patterns.
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When the configuration menus are set using the following operations, an
icon appears in the system tray and the status can be monitored by means
of the icon's pattern.

The icon patterns are explained below.

© Noproblem A

Problem

Procedure

) Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.

s«» ”%‘% . .
\£/ Select"Residentin the task tray".

Environment. setup

Update interval 5 3 minutes

Temperature level display group view @ 0Off © 0On

Lamp scheduls natification @ 0ff © 0On

1000 3: Hour

Log output & 0 C 0n

I~ Register at startup

I™ Change the application lock password

0ld password I

Mew pagsword I

New password [confim) [

0K Cancel

,@1 e Right-click the icon in the system tray to open a pop-up menu to select the
’ Open the main screen or Exit.

o If Register at startup in the Environment setup is selected, EasyMP
Monitor starts automatically when the computer's power is turned on.
When using EasyMP Monitor under Windows Vista or Windows 7, you
must have administrator authority in order to use this function.

Displaying projectors with problem or warning
statuses in a list

You can display a list of only the projectors which have a problem or
warning status.

Procedure

Select "Warning and Error Projector list" from the View menu.

The following Warning and Error Projector list window will be
displayed.
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If you move the mouse pointer over the icon of the Error information,
details of the error and the remedy will be displayed. If you double-click
in a line, the properties for that projector will be displayed. @ p.31

Refresh Sllect al LI) c} Eg%m‘gﬁgﬁﬁ@

Typel | Display namd | Powerd §Lamp Hours

Projectardl @ 120H
Ned @ 25H

Temperature levell | Error information

|
. | [ —]
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The icon patterns and their meanings are explained below.

O Type
Shows the group or projector status.
@@ No warnings or problems*1

ve Warning or problem

An error has occurred on the projector.
&4 Notification

The projector requires immediate attention.
. Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to
the projectors that are being monitored.

g Data being updated
@ Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered.
@ p.12,p.15,p.16
@ Network error (TCP connection error) 2
@ Network error (ESC/VP.net communication error)*3
@ Display name
Shows the display name.
9 Power
Shows the power on status for the projector.
@© Poweronandnormalstatus @) Power off and normal status

@\ Poweron and abnormal @) Power off and abnormal
status status

9 Lamp Hours
Shows the lamp operating time for the projector.
@ Ssource

Shows the input source that has been selected for the projector.

A @@ Computeror E @@l Computer2
QoL Computerl QoL=2
fToTolole BNC 5 S-Video

Video (RCA)

DVI-D1 or HDMIT,
DVI-D, HDMI™4

= D-Video (.555_:‘.:. EasyMP
asy
:;% USB Display Em| USB or USB1
EESSR USB2 fig LAN

® Temperature level

Video (BNQ)

The following five icons display the differing internal temperature
status of the projector.

=1 Internal temperature == Internal temperature

normal normal

[EEE ] High-temperature EEE= | High-temperature
warning warning

Internal temperature
error

@ Error information
Shows a warning/problem status using the following icons.
ﬁ Replace Lamp*6 71 Replace Lamp (Lamp 1)

@ Replace Lamp (Lamp 2) al Lamp error (Lamp 1)
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#
&

2% SHE

©

2 B EE 8§ =

B B

Lamp error (Lamp 2)

Lamp failure at power on
(Lamp 2)

Replace Air Filter

Low Air Flow

Supply System Error (Ballast
1)

Cinema filter warning
Lamp Cover Open

Lamp Error (Lamp 1)

Lamp failure at power on

Lamp failure at power on
(Lamp 2)

Low air flow error
Internal Error
Sensor error

Supply System Error (Ballast
1)

Auto lIris Error

Shutter error

Cooling system error
(pump)
Exhaust vent shutter error

& 2

E ENEd

nn
1

3 I

=y
el

&

2E &

=

>

Lamp failure at power on
(Lamp 1)

High-temperature warning

No Air Filter
Air Flow Sensor Err.

Supply System Error (Ballast
2)

Shutter warning
Lamp Error
Lamp Error (Lamp 2)

Lamp failure at power on
(Lamp 1)

High internal temperature
error

Air filter air flow sensor error
Fan error

Supply System Error
(Ballast)

Supply System Error (Ballast
2)

Cinema filter error

Cooling system error
(Peltier element)

Other error

Other warning

*1

*2

*3
*4

*5

*6

4
~ -
_ -
~
77

When Temperature level display group view is set to On at Environment
setup in the Tool menu, an icon indicating the internal temperature of the
projector will be displayed on top of the projector icon. The default setting
is Oft.

Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On)
or Network Monitoring is set to On in the projector's configuration menu.

Check that the projector has been correctly connected to the network.

It describes DVI-D if the projector is equipped with both DVI-D and HDMI
input terminal.
It describes HDMI if the projector is equipped with both DVI-D and HDMI
input terminal.

Using Environment setup in the Tool menu, you can set a duration of time
after which the Replace Lamp notification will appear. (The notification will
appear earlier if the lamp needs to be replaced before the selected time.)

Detectable error information differs with the projector you are using.

Checking properties in detail

You can check the properties of Group and projectors in detail.
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Displaying Group properties Displaying Projector properties
Procedure Right-click on a projector icon in Grouping view or Detail list view and
select Property.

You can use either of the following methods to display the proper-
ties. _ _
e Displaying the properties for all groups in Grouping view G name Branch A

Right-click in Grouping view and select Property. Proector name st

. . . . Dizplay name Lobby

e Displaying the specified group properties s (120228

Right-click an icon in Grouping view and then select Property. Larmp Hours a3

Temperature level o s
Drescription
Select ol B0 DD -RFEFTE =L g e 1

Type | Display name | Power | Lamp Hours Source | Temperature level | Error information I = = J

_@_ Showroom - e e e “Yereion information Eg E;ﬁamﬁ%\aﬂﬁﬂ

@ Convention He = e e e : : :

@ Labby @ H h@ Ermor information Mo signal

‘ 2l

@ Shows the projector's serial number. If hyphens are displayed, confirm

If you double-click in a line, the properties for that group or projector the serial number on the label of the projector.
will be displayed. @ Displays the projector firmware version.

Displaying and deleting logs

In your web browser, you can check a transmission log of content such as
what has been controlled by EasyMP Monitor and projector errors. You
can delete logs once you have checked them.
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AN/
;@: When Log output is set to On at Environment setup in the Tool menu,
! transmission logs are stored. The default setting is Off.

Displaying Log

Procedure

Select "Log" - "View" from the View menu.

The web browser will open and the communication logs up until that
time will be displayed.

Deleting Log

Procedure

Select "Log" - "Delete" from the View menu. When the confirma-
tion message is displayed, click "OK".

Alllogs will be deleted and details of EasyMP Monitor control operations
and details of projector errors from that point onward will be recorded in
a new log.
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Using the control functions

Carrying out control using control buttons

Click the icon of a projector to be controlled in Grouping view or Detail
list view, and click a control button to enable control of only that selected
projector.

You can also enable control of all selected projectors by selecting more
than one projector in Grouping view or Detail list view and clicking a
control button. The methods of selecting more than one projector at the
same time are as follows.

o If you select a group icon in Grouping view, all projectors that have been
registered in that group and that are set to be monitored can be
controlled at the same time.

¢ Hold down the Ctrl key on the keyboard while clicking on the desired
icons.
e Use drag and drop to select a range of desired icons.

File  Edit  View Tool Help

(00 %E%m@%.ﬁ%“"@

Branch B Branch C
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The following table shows the meanings of the control buttons.

o) Power On Turns the projector power on.
& Power Off Turns the projector power off.
- Switch source Switches the video input source to the
ool Computer1 Computer1 port or Computer port.
Switch source Switches the video input source to the
@B
oaD Computer 2 Computer2 port.
Switch source Switches the video input source to the BNC
°*® | BNC port.
Switch source Switches the video input source to the
=g S-Video S-Video port.
= Switch source Switches the video input source to the Video
Video (RCA) port or video2 port.
= Switch source Switches the video input source to the Video1
Video (BNC) port.
— Switch source Switches the video input source to the DVI-D1
=L DVI-D, HDMI 1 port or HDMI1 port.
If the projector is equipped with either a
DVI-D port or HDMI port (but not both), use
this button to select the input signal.
If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
DVI-D as an input source.
Switch source Switches the video input source to the DVI-D2
=2 DVI-D, HDMI 2 port or HDMI2 port.
If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
HDMI as an input source.
Switch source Switches the video input source to the D4
D-Video port.

Switch source Switches the input source to EasyMP or

EasyMP EasyMP.net.

Switch source Switches the input source to USB Display.
= . *
o= USB Display

Switch source Switches the video input source to the
" USB1" external equipment connected via a USB

(Type A) port or USB1.

Switch source Switches the video input source to the

H | usB2 external equipment connected via a USB2

port.

Switch source

© Switches the video input source to the image
Y4 |LaN'

projected by the computer via a network.

*

If the button does not function, you can switch the input source using the
button.

e Some connected projectors may not be equipped with all of the above ports
or functions. If you click a button for a port or function that is not
available, nothing will happen.

e You can select objects to be controlled and use the control buttons to carry
out control operations even when the following are being displayed.

Group properties @ p.31
Projector properties @ p.31

Warning and Error Projector list
(Control operations can only be carried out for projectors with a warning
status.) @ p.27
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Carrying out control using a web browser (Web
control)

You can use the computer's web browser to change the configuration
menu settings for projectors.

Procedure

Right-click on the icon of a projector to be controlled in
Grouping view or Detail list view and select "Web control".

The web browser will open and the Web control window will
be displayed.

Web control lets you set the same details as the configuration menu for
the projector. See your User's Guide for more information.

ANl

:@3 You can select projectors and right-click on them to select Web control
! even when the following are being displayed.

Group properties @ p.31

Warning and Error Projector list (Control operations can only be carried
out for projectors with a warning status.) @ p.27

Carrying out control using timer settings

This is useful for carrying out certain control operations such as turning

a projector's power on and off at specified times every day or every week.

Timer settings can be carried out either for a single projector only, or all
at once for all projectors in a group.

Procedure

Select "Timer" - "Timer Settings" from the Tool menu.

The following window will be displayed and you can then check the timer
setting status.

Projectors Dete
= B ranch A 4 0472008 »
= Corvention Hall
* gL:S;:” on e SUN | MON | TUE | wED | THU | FAI_| SAT
= [ showroom [ ! 1 2 2 4
=1 Lg, Showroom & S g + 7 ¢ 8 9 10 1
@ Mot 2 13 G 1 7 18
& Noz E 0 B E E] E] =
@ N3 % 7 % B Ell
=1 | &, Showroom B
@ Not
@@ NS Timers

6 Branch & = =
+ Branch € Display name Date Time (24 hour) Operation

Lobby 4{7/2009 18:43 Computer2

Showroom B 4(7j2009 18:45 Power ON

Mo3 4/7jz009 18:59 Pawer ON
4(7{2009 18:59 Power ON

Showroom A

_E g6

[< ] >

I Enabled Disabled I Add [ gdtI Delets O

Close | |

The details that can be checked and operations that can be carried out at
this time are given below.

@ Projectors

Selects a group or projector to check the status of.

When a group is selected, the timer setting statuses for all projectors
in that group are displayed.

@ Date
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Shows the current day in a red box. Procedures for new timer settings

Days for which timer settings have been made are shown in bold.
Click 4| or * | to switch to the calendar for the previous or next Procedure

month.
© Timers

Shows a list of the timer settings.

Click "Add" on the Timer Settings window. The following
window is displayed.

The line colors in the Timers list have the following meanings: Craate Hew Timer
LI Current day's timer
. Schedule mode ~
setting
L1 When some of the projectors in the group have timer Date 20090414 [
setting enabled and others have it disabled for the Time [24 hour) 1904 —=
current day's timer setting Operaton o O =]
| | When the current day's timer setting is a disabled setting
B Timer setting for a day other than the current day
@ Delete
B Lets you delete timer settings that have been selected
from the timer list.
ak Cancel
@ Close
Eee . Closes the Timer Settings window.
O Edit At Operation, you can carry out the operations of turning the pow-
= Lets you change the timer settings that have been er on and off and switching the input sources, similarly for the con-
selected from the timer list. If a group has been selected trol buttons on the main window. If you set the input source
for status checking, the settings cannot be changed. switching, the projector's power will turn on at the timer start time
@ Add even if it is not on at the time. Because of this, it is not necessary to

dd make two separate timer settings for turning the power on and

Registers new timer settings. (See the next section for o i
switching the input source.

more information.)
© Enabled/disabled

Enabled

After completing the timer settings, click "OK".
Switches the timer settings that have been selected from

beted  the timer list between enabled and disabled. The timer settings that have been made will be registered and they

can be checked in the displayed timer list.
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5@:— You can enable and disable all of the timer settings that have been
! registered. Select Timer - Enable or Disable from the Tool menu.
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Mail notification function settings

The mail notification function can be used to send corresponding
notification messages to a preset e-mail address when a projector that is
connected to the network assumes a certain status, or if it experiences a
problem or warning. By using this function, the operator can be notified
of a projector’s status or problems even when the operator is in a
different location from the projectors.

:@3 o Up to three addressees (destinations) can be registered and messages can be
! sent to all of them at once.

e If a critical problem develops with a projector which causes it to suddenly
stop working, it may not be possible for the projector to send a message
notifying an operator of the problem.

e If Standby Mode is set to Communication On (or Network On) or Network
Monitoring is set to On in the projector configuration menus, you can
monitor the projector even when it is in standby mode (when its power is
turned off). See your User's Guide for more information.

e On some projectors, the mail notification function can be set in the
configuration menu. When notification messages are set to be sent in the
projector’s configuration menu, both the settings in the configuration menu
and settings made on EasyMP Monitor are functional.

e Detectable status with the mail notification function differs with the
projector you are using.

Procedure

Select "Mail notification function" from the Tool menu.

b ail notification function

SMTP server IP address

Sender mail address

Recipient mail address 1

Recipient mail address 2

Recipient mail address 3

“ “ on

Part Mumber 25

Motification exent

|
|
| Motification event
|
|

notification event

oK Cancel

Make the necessary settings while referring to the table below.

Mail notification

Set to On to use the mail notification function.

function
SMTP server IP Enter the IP address of the SMTP server. Up to
address a maximum of 255 bytes can be entered.

When you change a port number of the SMTP
server, specify this port number. The default
value is "25".

You can enter a valid number from 1 to 65535.

Sender mail
address

Enter the sender's e-mail address. Up to a
maximum of 255 bytes can be entered.

Recipient mail
address 1

Recipient mail
address 2

Recipient mail
address 3

Specify the destination addresses for the
notification e-mail. Up to three destinations
can be set. Up to a maximum of 255 bytes can
be entered.




Mail notification function settings

Click "Notification event" and check the items for mail
notification in the window that appears.

Set notification event

|

Lamp
¥ Replace Lamp
¥ Lamp failure at power on
¥ Larmp Cover Open
W Larnp Error

Air Filker

W' Clean Air Filker Natice
[V Mo air Filter 4

W Law Air Flow

¥ Replace Air Filter

W Air Flaw Sensar Enr.

W Air filter air flaws sensor emar

V¥ Low air flow error

Metwark,
™ Metwaork error [TCP connection ermar]
[ Metwork error [ESCAP.net communication error)

™ Metwork error [monitor password authentication eror]

|£

Cancel

'n)
' Click "OK".

The Set mail notification function window appears again.

Repeat Steps 3 and 4 to set the notification events for the other
email addresses.

o,

'
\2/ When the setup is complete, click "OK".
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An e-mail notifying the operator of a problem/warning/status is issued
If the projector experiences a problem or enters a status requiring
attention, an e-mail like that shown below is sent to the address specified
for Recipient mail address.

If there is more than one problem, warning, or status, the corresponding
messages are output to separate lines.

Item Details shown

E-mail subject [Display name displayed in Grouping view or Detail
list view] Projector status notification

Body <Display name displayed in Grouping view or Detail
list view> has entered the following status.

<Warning/error/status message> (Please see the
next table)
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The details contained in the e-mail message can consist of the following.

Message

Remedy

Message

Remedy

Internal Error

Fan error

Sensor error

Stop using the projector, disconnect the power

cable from the electrical outlet, and contact Epson.

See your User's Guide for more information.

Supply éystem Error
(Ballast)

Replace Air Filter

No Air Filter

Lamp Cover Open

Lamp failure at power
on

Lamp Error

See your User's Guide for more information.

Low Air Flow

Air Flow Sensor Err.

Cinema filter warning

Shutter warning

Supply éystem Error
(Ballast)

High internal
temperature error

Low air flow error

Air filter air flow
sensor error

Cinema filter error

Shutter error

Cooling system error
(Peltier element)

Cooling system error
(pump)

Stop using the projector, disconnect the power

cable from the electrical outlet, and contact Epson.

See your User's Guide for more information

Clean Air Filter Notice

Exhaust vent shutter
error

Air filter air flow
sensor error

Low air flow error

High internal
temperature error

Other warning

Other error

See your User's Guide for more information.

High-temperature
warning

Replace Lamp*

*
Lamp error

Lamp failure at power
on

See your User's Guide for more information.

No signal

No image signals are being received by the
projector. Check the connection status and check
that the power for the connected equipment is
turned on.

Auto Iris Error

Stop using the projector, disconnect the power
cable from the electrical outlet, and contact Epson.
See your User's Guide for more information.
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Message Remedy

Network error (TCP Check the following items.

connection error) Check that the projector's power is turned on.

Check that the LAN cable is connected.

Check that Standby Mode is set to Communication
On (or Network On) or Network Monitoring is set to
On in the projector's configuration menu.

See your User's Guide for more information.

Network error Check that the projector has been correctly
(ESC/VP.net connected to the network. See your User's Guide for
communication error) | more information.

Network error Check the projector's Monitor Password.
(Monitor Password
authentication error)

*  When the projector has 2 lamps, the additional information, such as (Lamp

1) or (Ballast 1), is displayed after the message so that you can know which
lamp has problems/warnings.

Messages to inform that the projector has recovered from the error or
warning statuses are sent.
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Application lock function / The password entry window will be displayed, so enter the

You can use the application lock to prevent third parties from operating ~ set password and then click "OK".
the projectors using EasyMP Monitor and from changing settings
without authority. Opening and closing EasyMP Monitor and status
monitoring can still be carried out even when the application lock is
applied.

If no password has been set (default setting), click OK without en-
tering a password. It is recommended that you enter a password in
order to strengthen security.

The application lock will be cancelled and operations can be carried

In addition, when a password has been set, the password must be entered out as normal.

in order to cancel the application lock. This ensures that the application
lock can not be easily cancelled, and thus improves system security.

Setting a password for cancelling application lock

Switching Application lock between enabled and Carry out the following operations while application lock is cancelled.
disabled

Procedure

§&\‘“‘WH””’%%
Enabling the application lock %@ Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.
Procedure
Select "Change the application lock password".
Select "Application lock" from the Tool menu.

The application lock will be enabled and no operations will be possible 2/ Enter the password in both the "New password" and "New

other than opening and closing EasyMP Monitor and disabling the password (confirm)" boxes and then click "OK".

application lock. The password can be up to 16 bytes in length. Single-byte alphanu-
meric characters can be used.

Disabling the application lock
Procedure

%@§ Select "Application unlock” from the Tool menu.
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Troubleshooting

Troubleshooting

An e-mail message is not sent when a problem occurs
with a projector

Projectors cannot be monitored or controlled

Cause

Remedy

Cause

Remedy

Is the projector connected
to the network correctly?

Check that the network cable has been
connected correctly. If the cable is not
connected correctly, reconnect it.

Is the projector connected
to the network correctly?

Check that the network cable has been
connected correctly. If the cable is not
connected correctly, reconnect it.

Has the projector been set
up correctly for
connection to the
network?

Check the Network configuration settings.
See your User's Guide for more information.

Has the projector been set
up correctly for
connection to the
network?

Check the Network configuration settings.
See your User's Guide for more information.

Has EasyMP Monitor been
installed on the computer
correctly?

Uninstall EasyMP Monitor and then re-install
it. @ p.8

Have the SMTP server IP
address, Port Number and
Recipient mail address all
been set correctly?

Check the setting details.

Are all the projectors that
you want to control or
monitor registered?

Register the projectors. @ p.10

Is the projector's Standby
Mode set to
Communication On (or
Network On) or Network
Monitoring setto Onin the
configuration menu?

In order to use EasyMP Monitor to monitorand
control the projector when it is in standby
mode, the projector's Standby Mode must be
set to Communication On (or Network On) or
Network Monitoring must be set to On in the
configuration menu.

See your User's Guide for more information.

Is the projector's Standby
Mode set to
Communication On (or
Network On) or Network
Monitoring settoOninthe
configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby
mode, the projector's Standby Mode must be
set to Communication On (or Network On) or
Network Monitoring must be set to On in the
configuration menu.

See your User's Guide for more information.

Has a critical problem
developed causing the
projector to momentarily
stop working?

When the projector has momentarily stopped
working, it cannot send e-mail messages. If the
projector cannot be reset even after it has
been checked, contact Epson. See your User's
Guide for more information.

Is power being supplied to
the projector?

Check if the power supply to the location
where the projector is set up has been
interrupted, or if the circuit breaker for the
electrical outlet that the projector is
connected to has been tripped.




Uninstalling EasyMP Monitor

Uninstalling EasyMP Monitor

The following procedures to uninstall EasyMP Monitor vary depending
on your operating system.

e If your operating system is Windows 2000 or Windows XP

Click Start - (Settings) - Control Panel - Add/Remove Programs or
Add or Remove Programs to uninstall EasyMP Monitor. To save or
transfer the existing projector settings, make a copy of the EMP
Monitor.dat file before you uninstall the software. @ "Transferring
the settings" p.7

e When your operating system is Windows Vista or Windows 7

Click Start - Control Panel - Uninstall a program to uninstall EasyMP
Monitor. The settings and logs remain on the hard disk after EasyMP
Monitor is uninstalled. If you do not need this information, delete the
EasyMP Monitor Ver. x.xx (Ver. x.xx represents the version of the
existing software) folder. This folder can be found at "C:\Users\(User
Name)\AppData\Local\VirtualStore\Program Files\EPSON Projector"
if the default settings were used to install the software. To save or
transfer the projector settings, make a copy of the EMP Monitor.dat file
before you delete the folder. @ "Transferring the settings" p.7



General Notice

General Notice

All rights reserved. No part of this publication may be reproduced, stored Trademarks

in a retrieval system, or transmitted in any form or by any means,
electronic, mechanical, photocopying, recording, or otherwise, without
the prior written permission of Seiko Epson Corporation. No patent
liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the
use of the information contained herein.

Microsoft, Windows, Windows Vista, Windows 7, and Windows logo
are trademarks of Microsoft Corporation in the United States of America
and other countries.

Macintosh is a registered trademark of Apple Computer, Inc.

Pentium is a registered trademark of Intel Corporation.

Epson, EasyMP, and EasyMP.net are registered trademarks, and Epson

Neither Seiko Epson Corporation nor its affiliates shall be liable to the Exceed Your Vision is a registered logomark of Seiko Epson

purchaser of this product or third parties for damages, losses, costs, or Corporation.

expenses incurred by the purchaser or third parties as a result of: Other product names used herein are also for identification purposes
accident, misuse, or abuse of this product or unauthorized modifications, only and may be trademarks of their respective owners. Epson disclaims
repairs, or alterations to this product, or (excluding the U.S.) failure to any and all rights in those marks.

strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable against any damages or

problems arising from the use of any options or any consumable ©2010 Epson America, Inc.
products other than those designated as Original Epson Products or 6/11
Epson Approved Products by Seiko Epson Corporation. CPD-34801

This information is subject to change without notice.

Ilustrations in this guide and the actual projector may differ.
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